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Overview

BlueVault is a Microsoft SharePoint based portaldais essentially a
light version of out offering. allows your organization to manage extranet applications and
related account provisioning via a central extranet directory.

Central IT can grant application owners necessary rights to send an aetbramail invitation to
external users which grants them the ability to selfjister and setadminister their own credentials.

gl: BlueVault
[ome]

Home
N Welcome to the BlueVault Account Manager BlueVault Sign In:

To change your password, edit your profile or change your challenge questions Password: L ]
and answers, please select the "Self Service” link. ﬁ

BlueChip

Cansulting Grow,

®2003 Blue Chip Consulting Group, LLE. All rights reserved.



Access Levels

I dzZaSNRa | 00Saa f S@S Bluevaul The fall@ing @lgareidviibledza SN & NRE S

Roles

1 StandardUses¢ default user role allows for user selervice functions
1 Resource ApplicationOwnersg manage theapplicationresources that they own
1

Administrators¢ all of the above plus the ability tadd, change and deletlueVault
accounts ancdit the BlueVaultconfiguration

1 System Admimg manage the underlying BlueVault configuration and language translation

The different levels of access will show up as navigation tabs at the top efeh@age and quickink
headers on the lefhand side.

)i Bluevault —

i Self-Service I Identity I Resource Owner I Admin I System Admin |

Home

st o Welcome to the BlueVault Account Manager

Identity
i ] To change your password, edit yvour profile or change your challenge ques
Resource Owner "Self Service” link.
Admin
System Admin My Resources

BlueVault Admin Access
BlueVault Resource Owner Access
Marketing Site Visitor Access

Each of theseoles correspondo an Active Directory security group. These groups must be managed via
BlueVaultand should not be directly edited in Active Directory. Modifications to the Active Directory
groups will be overwritten by thBAM synchronizatn routines.



Self-Service Tasks

Challenge / Response Enroliment

A usermust settheir answers to the challenge / response questions betbiey will have the ability to
resettheir password.

| BlueVault

Home

Welcome to the BlueVault Account Manager BlueVault Sign In:
Email:

To change your password, edit your profile or change your challenge guestions Password:
and answers, please select the “Self Service” link. -

» Reset My Password

0:Elue.lcenip_/

cansulting Gr

©2009 Blue Chip Consulting Group, LLC. All rights reserved.

1 Login toBAM

| BlueVault (o] Sl | )

Home

1 User Self Service
Self-Service

» Change Password

» Edit My Profile To change your password, select Ehe "Change Pa"ss_wo rd” link.

To update your profile, select the "Edit My Profile” link.

To change your challenge questions and answers, select the "Challenge Questions” link.

» Challenge Questions

—

Qluechip

Cansulting Group

2009 Blus Chip Consulting Graup, LLC, All rights reserved.
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Home

Self-Service Challenge Questions

#» Change Password Please select three verification questions and type in your answers.
» Edit My Profile What was the model of your first car? -
5 Challe_nge [ |
Questions :
What was the model of your first car? -
What was the model of your first car? -

W Blue\ault (o] = e

QE!HESWD‘D

T /ftA01 2y GUKS &/ KK Sy3aS vdzSadirzyas
0 The questions will be itheir default language
o {SS a5SFldzZA G [l y3dda 3S { St SOlAz2yé
1 Select three different validation questions and enter the answers
T /ftA01 GKS a{dzoYAilé¢ odzidzy
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Password Reset

If a user has already set theanswers to the challenge questions atiey forget their password they
will have the ability to reet it from BlueVaulAccountManager.

W BlueVault

Home
Welcome to the BlueVault Account Manager BlueVault Sign In:

To change your password, edit your profile or change your challenge questions Password: 7]
and answers, please select the “Self Service” link. -

» Reset My Password

g BlueChip_

amsulting

©2009 Blus Chip Consulting Group, LLE, All rights reserved.

9 Browse toBAV
il {StSC)G GKS awSasSlink aé@ tl a3dg62NRE dez)\él

W BlueVault
[Home |

Home

 Reset My Reset My Password

Password B
Please enter your email address

|jcu stomer@test com

Qluechip_J

Cansulting Group

©2009 Blus Chip Consulting Group, LLE, All rights reserved.

1 Entertheir email address
T /ftA01 GCAYR aS¢



| BlueVault account Manager

Password

Home
, Reset My Reset My Password

Please enter your email address
jcustomer@test.com

What was the model of your first car?

What is the last name of your best friend?

What is your favorite color?

Qfluechip_/

amsulting Group

©2009 Blue Chip Consulting Graup, LLE, All rights reserved

1 Answerthe three challenge questions

T /tA01 &/ KFry3aS t1l 5462 NRE

BlueVault account Manager

Home
» Raset iy Ser Reset My Password

Processing transactionid:1b7e237b-df02-43f8-a052-76e8cc0a763f
jcustomer@testcom

Password:

Confirm Password:

’Bluech

A g
©®2009 Blue Chip Consulting Group, LLC. All rights reserved.

1 Enter and confirntheir new password
T / £tA01 a{dzoYAi¢



Password Change

Users dohave the ability to changeheir password viaBAM. This will automatically updat¢he
corresponding Active Directory password.

i BlueVault

Home
» reset my e Welcome to the BlueVault Account Manager BlueVault Sign In:
Email: jcustomer@test.com

To change your password, edit your profile or change your challenge questions Password:
and answers, please select the "Self Service” link. -

Qluechip_,

cansulting Graw

©2009 Blus Chip Consulting Group, LLC. All rights reserved.

1 Login toBAV
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[Cogar ] BNl

Home

Change My Password

Self-Service

» Change Password Current Password

» Edit My Profile [eneecees |
New Password

[eeveenee |
Confirm Password

» Challenge Questions

—

QlueChip

cansulting Group

©2003 Blue Chip Consulting Group, LLC. All rights reserved.

/I £t A01 (K3 ac/oRINRES |j dzA O
Entertheir current password

Enter and confirntheir new password

/| £t A0l a{dzoYAl:é
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Profile Updatin g

Users havehe ability to set profile attributes as well as view existing account information.

% BlueVault

Home
» reset my e Welcome to the BlueVault Account Manager BlueVault Sign In:
Email: jcustomer@test.com

To change your password, edit your profile or change your challenge questions Password:
and answers, please select the "Self Service” link. -

QlueChip_f

cansulting Group

©2009 Blus Chip Consulting Group, LLC. All rights reserved.

1 Login toBAV
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Home

Self-Service

» Change Password

» Edit My Profile

» Challenge Questions

{ St SO

= =4 =4 4 =

/£ A0

Edit My Profile

D

Login Name

First Name

Middle Name

Last Name

Display Name

Description

|

|
Preferred First Name | oe

|

|

|
|
|
|
|
|
|
712009 'Z:IIHII:IJIII-J

Company

EN==e il —

|test com

Department

[T

©2009 Blue Chip Consulting Group, LLC, All rights reserved.
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Userscan viewtheir existing account information.
Any attributes that are user editable will appear as a text input box
Enter the newprofile information

tAyl



Default Language Selection

BlueVault

isavailable in several different languagéiserscan settheir default
language ad BAM will always change to that language oribey login.

| BlueVault

Home

» Reset My Password

Welcome to the BlueVault Account Manager

BlueVault Sign In:

Email: jcustomer@test.com
To change your password, edit your profile or change your challenge guestions Password:
and answers, please select the “Self Service” link. -

QaluegnipJ

ensulting Gr
©2009 Blus Chip Consulting Group, LLC, All rights reserved.

1 Login to BM

W BlueVault

[Cogout] BN N==e Bl —

Home
: Welcome to the BlueVault Account Manager

Self-Service
To change your password, edit your profile or change your challenge questions and answers, please select the
"Self Service” link.
My Resources
Marketing Site Visitor Access

g BlueChip—
Camsulting Sreup
®2009 Blue Chip Consulting Group, LLC, All rights reserved.

Click on the flag icon that correspondstieir preferred language
1 BAM will change to that language



] BlueVault i) Sl () D

A XM B P
BERRS

ERTEENED, REEOTAES, ERES, ERNEE, SBERENER, BLE THIRSY .

My Resources
Marketing Site Visitor Access

Qluechip—“

Cansulting Gro:

©2009 Blue Chip Consulting Group, LLC. All rights reserved.

1 Example of B¥ in Chinese
1 Ifthe userresetstheir answers taheir challenge questions, the new questions will bethir
default language.



Resource / Application Owner Tasks
¢KS NB&a2dzNDS 26y SNI Gl al1a | NB | g A f-inloheasler.dzy RSNI (G KS

Provision Owned Resource

This allows a resource owney provision the resources that they own to any active BAM account.

ﬁcngﬂueVéuﬁ [Cogout] L Sewm) | X R
| Home |
Home
Select Resources Select Users
Self-Service | [jim |
Resource Owner Corporate Cleveland-Marketing Members

Corporate Cleveland-Marketing Owners
Corporate Cleveland-Marketing Visitors

» Provisioning
» Deprovisioning

» Invite

©2009 Blus Chip Consulting Group, LLE, All rights reserved.

9 Select one or more resources to provision

9 Enter the account filter criteria

1 Press <Enter>

9 Select one or more accounts to provision the resource(s) to

T / tA01 awSljdzSad LINRPQGAAA2YAY3E

The seleted resources will automatically be provisioned to the accounts. Since this is the actual owner
of the resource, no workflow approval will be required.



De-Provision Owned Resource

This allows a resource owner to-geovisionBAM accounts from the resoues that they own.

ﬁiB lueVault [Cogout ETI e Bl —
| Home |
Home
1 ] Corporate Cleveland-Marketing Visitors =
Self-Service Display Name iD Last Name First Name Middle Name Select
Resource Owner Customer, Joe 100015 Customer Ooe D
» Provisioning Smith, Jim 100012 Smith 3im

» Invite

Chip

Cansulting Graup

©2009 Blue Chip Consulting Group, LLC. All rights reserved.

1 Select one of the owned resources

9 Select one or more accounts to-geovision from that resource
0 Use the filter box to narrow the search

T /ftAOCINBEGBaAA2YE

The selected accounts will be automatically removed from the selected resour



Invite Users to Access an Owned Resource

This allows a resource owner to invite a user that does not currently have a BAM account to register to
BAM and access the associated resource / application.

o | ) BlueVault M ST

[ Home |
Home -
Select Resources Enter email addresses
Self-Service [ |
Resource Owner Marketing Members- Joan.customer@test.com -
i} i Marketing Owners-
» Provisioning Marketing Visitors-

» Deprovisioning

» Invite

®©2009 Blue Chip Consulting Graup, LLC. All rights reserved.

i Select one or more of the owned resources.
1 Enterthe email address of one or more external users to send an invitation to.
T /ftA01 aLYy@AaAlGSE

An invitation will be sent to the user with a link to the BAM registration process.



-] BlueVault Account Manager registration notification - Unicode (UTF-8) EI@
File Edit View Tools Message Help
P Reply #% Reply Al #® Forward

From: idportaladmin@company local =idportaladmin@company local=;
Date: Tuesday, September 22, 2009 10:50 AM

To: joan.customer@test. com =joan.customer@test coms=;

Subject: BlueVault Account Manager registration notification

kR kkEsiix PLEASE DO NOT REPLY TO THIS MESSAGE®* %= & ssiinix
Dear joan customer(@test.com.,

You have been invited to register with BlueVault Account Manager. To continue the registration process, please select
the following link:

BlueVault Account Manager Registration

This link can only be used one time and should be discarded.
Thank You.

BhieVault Administration

This is a sample email the will be received by the user. The user shouldncliek @gistration link and
register with BAM.



BlueVault
—

Home

Register

» Reset My Password

Processing transactionid: 526b3a33-3f59-456a-b60b-89e571a89b7d

joan.customer@test.com

New Password [ |

Confirm Password | |

First Name *

Middle Name

Last Name *

C ¥

Department

Please select three verification questions and type in your answers.

What was the model of your first car? -
What was the model of your first car? -
What was the model of vour first car? -

[ |
i ...

Caneulting Group

©2009 Blue Chip Consulting Group, LLC. All rights reserved.

The user should fill in the required information, answer their password reset challenge questions and
Ot A01 awS3aAaildSNE



Account Admin Tasks

Theaccountadmii 41 & | NB f 2 Ol (i SR ordpycRliSkNkadek S G L RSy (A

S BlueVault

[ Home | seif-service | | Resource owner | Admin
" Identity M t
Self-Service entity Managemen
Identity . _ _
»View il To view or modify non-employee accounts, dlick the "View/Modify" link.
ievr/bicaiy To add a new non-employee account, click the "Add" link.
» Add To delete a non-employee account, click the "Delete” link.
» Delete To request provisioning for a non-employee account, click the "Provisioning” link.
» Provisioning
Resource Owner
Admin

{Cogout] =lem | __ Y o

leuech

e=l'P

©2009 Blus Chip Consulting Group, LLC, All rights reserved.

The followingaccount admirtasks are available:

View / modify account

Add account

Delete account

Terminate account
Provisioned resource request
Emergency account disable

= =4 =4 =4 -8 -4



View / Modify Managed Account

This is used to view / modiBccount information for managed neemployee accounts.

; ) Blue\/ault —) = )

| Home | Seff-Service | | Resource Owner | Admin |

Home
1 ] - All - - Al -- v —al—- v

Self-Service Display Name ID Last Name First Name Middle Name Disabled

Identity Choi, Eugene (Blue Chip) 100000 Choi Eugene False
Creekmore, Mark (Blue Chip) 100001 Creekmore Mark False

» View/Modify Customer, Joan 100016 Customer Joan False
Customer, Joe 100015 Customer Joe False

» Add OWnNer, resource 100013 owner resource False

» Delete Smith, Jim 100012 Smith Jim False
Willard, Eric 100011 Willard Eric Falze

» Provisioning

Resource Owner

Admin

©2009 Blus Chip Consulting Group, LLC. All rights reserved.

This shows a list of all ¢ie managed noremployee accountdJse the drop down lists and filter box to
narrow the search.



Home

Self-Service
Identity

» View /Modify
» Add

» Delete

» Provisioning

Resource Owner

Admin

5 ‘ BlueVault (] B o

| Home | Self-Service | | Resource Owner | Admin |

— Al -- v <Al = Al v[jee

Display Name D Last Name First Name Middle Name Disabled
Customer, Joe 100015 Customer Joe False

Login Name

Type

First Name

Middle Name

Preferred First Name

Display Name

| |
| |
| |
| |
Last Name [ |
| |
| |
| |

Description

Division

Location

owner

Termination Date |

[T BRI ©>

©2009 Blue Chip Consulting Group, LLC, All rights reserved.

I Select an account to see further information
f To modify the account, @1 (G KS daz2RAFeé¢ odzildzy
0 This allowsan account admiro do the following tasks:

A

> > > >

>

Edit the display name
Edit the description
Change the division cod€ategory Code 1)
Change the location cod€ategory Code 2)
Change theaccountowner/ manager
Set a Terminigon Date
9 The account will be automatically disabled on that date
Terminate Now
1 Immediate termination of the account



5 ‘ BlueVault —

| Home | | Admin |

Home

— Al -- v Al o Al v[je
Self-Service Display Name D Last Name First Name
IdEIltit\[ Customer, Joe 100015 Customer Joe
» View fModify
» Add Login Name [ |
» Delete? . Type | |
» Provisioning

First Name [ |
Resource Owner

Middle Name [ |
Admin

Last Name [ |

Preferred First Name | |

Display Name |cuatomer,Joe |

Description [Registered an 712712009 12:00-00 4

Division Corporate -

Location Cleveland -

creekmaore

Creekmore, Mark (Blue Chip
Owner

Termination Date | |

@2009 Blue Chip Consultina Group. LLC, All riahts reserved.

EN==e BN —

Middle Name Disabled
False

>

¥ BlueChip

Iting Gra:

Thedisplay name and description atiree forme text fields and can be manually edited.

The two category codes (used for division ancat@mn in this instance) can be selected via drop down

boxes.
To change the account owner / manager:

1 Enter the account owner filter string in the filter text box.

i Press <Enter>

9 The list of accounts that match the filter criteria will be displayed
9 Select tle new account owner

T /tA01 a{l @S¢

To set a termination date for the account:

> Cn
O« »
U))C\
M- (7))

T 9yGSNJ I R
T /tA01

I
a{l o

Ay GKS F2N¥Y 2F aYYKRRkedadadé 2N dz



Add Managed Account

¢ KS &! RIRE alldjvsak adcpount admind createamanaged account.

Home
] Type
self-Service .
First Name
Identity Middle Name
» View/Modify Last Name
» Add PreferredFirstName
» Delete i
Email
» Provisioning R
Display Name
Resource Owner Description
Admin Division
Location
Owner

Termination Date

Password

Confirm Password

To add a managedccount:

Enter the required attribute information
Select the division and location codes

Enter the Termination Date (if required)

Vendor Account

Corporate -

Cleveland ~

Enter owner filter below...

Creekmaore, Mark (Blue Chip)

{Cogout] = B _ Y o

Qluechip

Consulting Group

©2009 Blue Chip Consulting Group, LLC, A&l rights reserved.

1
1
1 Select the ownef supervisor
1
1

/£ A01 6! RRE



Delete Managed Account

This allowsan account manageio delete anon-employeeaccount.

[Cogou ] BN e BN —

preferred First Name [Joe

Home
_ — Al - Al v Al - [joe |
Self-Service Display Name | D | LastName |  FirstName | Middle Name | Disabled
Identity Fustnmer, Joe \ll]Dl]lS \Custnmer |]oe | |Fa|se
» View/Modify
» Add Login Name [icustomer@iest.com |
» Delete ~ - s
i Type [Vendor Account |
» Provisioning
First Name |Jce |
Resource Owner
I Middle Name [ |
Admin
Last Name |l3us’.cme’ |

Display Name ||2uszume: Joe

Description |Regis:e red on 7/27/2009 12:00:00 4

Division

Location

None
Owner

Termination Date |
o= L.
"3 Group

®2009 Blue Chip Consulting Group, LLC, All rights reserved.

9 Select the account
I View the details of the account
¢ /ftA01 GKS a5StSiS¢ odzitzy



Provisioned Resource Request

This allowsan account admirto request that a resourcé applicationbe provisioned to an existing
account.

| BlueVault —) = o

[ Home | [ Admin
Home
] — Al - v —Al- v —-All—  +[jge
Self-Service Display Name D Last Name First Name Middle Name Disabled
Identity Customer, Joe 100015 Customer Joe False
» View/Modify Division |Location|Provisioned ResourcesDescription/Select
» Add CorporateClevelandMarketing Visitors =

» Provisioning

Resource Owner - Al-- . Al -
At Division |[Location| Available Resources Description Select]
Blue Chip Website \&n example resource. [

Portal Administrators

Portal Resource Owners

CorporateClevelandMarketing Members

i

CorporateClevelandMarketing Owners

9Eluecnip

Cansulting Gro:

©2009 Blue Chip Consulting Group, LLC. All rights reserved.

1 Select theaccountto request a resource for

1 This shows the current provisioned resources and the available resources
9 Select one or more available resources

T /A0l awSldzSad t NPGAaAA2YyAYyAE

When the provisioning request is approved, the resource will automatically beigwoed to the
account.



Emergency Account Disable

This allows you to disable access for that account on all provisioned resources.

[Cogou ] BN Ao E—

Home
_ —All - v Al v Al ~[oe |
Self-Service Display Name | 0] | Last Name | First Name | Middle Name | Disabled
Identity :Customer, Joe |1I]DDIS |Customer |Jne \False
» View/Modify Division [Location|Provisioned ResourcesDescription/Select]
» Add

CorporateClevelandMarketing Visitors

» Provisioning

Resource Owner -al-- e -all-- -
Admin Division [Location|Available Resources Description Select
Blue Chip Website l&n example resource.

Portal Administrators

Portal Resource Owners|

CorporateClevelandMarketing Members

CorporateClevelandMarketing Owners

i e

QIueChip

Cansulting Group

©2009 Blue Chip Consulting Group, LLC. All rights reserved.

M Select the account that tbe disablal
T /ftA01 GKS Ga9YSNHSyOeé 5AalofSé¢ odzitizy



9 The account is nowisabled
 Toreenabled KS | O02 d& Vil ®f $O1 awS


































































